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®  [REUHMAHEE fF, RECH A& .

®  ARLIRMN, BRI,

6.1.3 FIEHp

R 3 SRR DA R A S A A AR I T

R 3 EIRBAEEIR

Ry

Run Test CGizf7Tilli{)

L

THEBTIRTF GES R 5.3 %) . QlAstat-Dx ¥l H Zhik#HaT F 4t
BRI LMK %751

FIHF View Results (EHFLER) hift GESHNH 5.4 19

View Results (£ F 45 %)

Options (&31) 7% Options GETID F3&8H GEZSHE 6.4 79) .

@00 O

Log Out (7E44) PSS (INAERE R T User Access Control [FH F i il 4% i) A 20 .

6.1.4 HEXI

ENH X BREE RSB A EER ST A T 3EAA FIBEIFAE T SCHTE e b
WEEEIH N, SEZXIRhRRaE R, M8, IEMIKE.
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RI\PZE, B IETRSE A Options GETD SEHRAEFTELIET. % F Options GETD $#
FEIAS 715 Options GETD F3H (F 43) .

administrator Test Details 14:49 2017-03-30

—] Available
Run Test

View
Results

Q0® 0O

User Assay  System Change Optit
MGMT MGMT Config Password

o
3
@

®

Log Out

& 43.i5 9 Options (D) FIE&E,
6.2 BRHEH

W BAT User Access Control (I Uiz GESRE 6.5 F1) , NIH A Wil &5k
W E TR Sy, XA AT QlAstat-Dx Analyzer 1.0 Ljjfg.

BERR: F-®ExXN, HFP ID A  “administrator” (FHG) , BRILFWLA
“administrator” . 5 — 8 T 5 0 A R

BEREAAEXBASHTHARP ID MXAE (F—T0E 44) . WR%EHE T Show
previous user logins R/~ ZHTFIH B3R ®I, Mk B8 2R INERN 5 MHFHFIR.

Wan: B T AR AR E R EbR A BEH QIAGEN AU Gt

No user LogIn 12:40 2013-02-15

User ID Password

abuser

administrator

& 44. Login (B3F) F#.
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AR R AN AFRECR T User ID (A ID) SCAHE A T RE $0LBE A 4 N\ A4 R BRI AT B\
M 4. SaANRP A JE, 15N A L S Ebric BT il (& 45) .

No user Login 16:38 2017-03-30

user D |abuser Password

X space v

Bl 45 fil 257 b iRl gR AL .

WREE T Require password (FEHMD) &, GEZME 6.5 1) , MESERAFHAZE
T B ADAE A B AL . IR TR0, U B SCAAE R 2 B K

WERH M EICEH S, 248 Administrator GRS 7] DLE B %6,

e WREEREICTHE, MRAEH QIAGEN HAMRSEHITEE, XFE QIAGEN REL
FRIRREII . R B — AN K.

WAL, R =IEAIREEN, R SP0E, P E— a4 se g,

Wan: MRYE ST LN 4% 2 A BORRE R

6.2.1 JF4H

BT User Access Control (Vi) GES M 6.5 1) , A/ alBE 3 3328
) Log Out GRS JEDUKRESS. LA 6.1.3 7.

BT BB R, K BB . IR T AR Options (T SEHLY General settings
CEIRE) TRE GEZM% 6.7.2 %) .

QlAstat-Dx Analyzer 1.0 f1/*F/it 04/2019

50



6.3 FtamiryIERT

WS FETIE SR () B Y RT3 B, M B7R QlAstat-Dx BERRYFRT . I [H]
A[#E Options 1) FHHEE GESHE 6.4 1)

B R o 1 20 M R (8 m A DA 58 AT B0 Rif T) (181 46)

B 46 REARYRER BonE — N B TRES

6.4 RIS

Options X SEHATBLA T BT . R 4 Son 7R AT U AL, ANl i A 4 04y
wEK.

R 4IETRE

£

Assay Management
R 22D

L
AT AT AR Aty PP SR A

AL A AR A R L 7 AR O E S

User Management
CHPE D

System Configuration AR SR KB B R S

(REGMED

© © 0 O

Change Password WIS T User Access Control CFH P U7l d% ) , iz ik sin] i .

CE B
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6.5 HP&EM

QlAstat-Dx BAFARH Rif, ATASCREAFEME S 5. X TR E R, A LR BEAT A

e “Single User” CHLAI/) #=: User Access Control (FH i falisdi) C&4E/H, Aaxts
5% QlAstat-Dx Analyzer 1.0 f)H 7 #EAT A4S A H %0 LU QlAstat-Dx Analyzer
1.0 METAEThEE, A ATATRRE

e “Multi-User” (ZHI/") #x: User Access Control (I UiaisHD ELBM, R RLIE
%, SREAREAE QlAstat-Dx Analyzer 1.0 EHUATHRAE. ARVHIATHAT IHRIE S ZRIRG], 2
R4 FC P e & SO e

#7~: User Management (F P& H) EIWALEH FEH “ Administrator 7 (8 # 51) 8¢

“Laboratory Supervisor” (SUIGEFE) MBI

#oR: ATLAFE Options (&I EH#HY System Configuration (RZECE) T General settings
CHIBEE) H )8 FHskZE User Access Control (F 5 il )

User Management (/& #) %I L ¥ A “ Administrator” (& ¥ 2 ) Al “ Laboratory
Supervisor”  (SEGE FED TESCAMA P NRGRIFH L 8 CUBRATH - i E S
PAS s AR R

#* 5 &7~ T QlAstat-Dx Analyzer 1.0 ma] DL F ) FH 7 lid B S

2 5.QlAstat-Dx Analyzer 1.0 #A] DA B9 P AC & S0 f:

Jiilal -8 03 R =4
Administrator Se4 UEAERANT 54T
CEHLBD
Laboratory Supervisor ¥ SRS E M TN
CsiEsss) AERESE £ | AT
AT FF A ) 5 5
Advanced User BATAEI AR SR E RN G
R BB PR TS R g 4 )
Basic User BATAI By7 fR SRS (Bldn, 4
A B A R AL B B/ B P45 5D R ARHRAS)
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6.5.1 ViR AL A

IR LT D PRI M MV B AR G

1. % F Options (ZET) %40, RJ51%F User Management (A EHD) 4 RECE A 7. BoR
FRHIMA X 2 H I User Management (3D RE (K 47) .

administrator User MGMT 14:49 2017-03-30
—I Available °
Run Test
USER
administrator > e
technician > =
View
labuser > Leauite
Options
Log Out
20 adduser E] save ® cancel

& 47.User Management (PS8 BE.

2. WARXI M TSI RIEFEE M (& 48) .

administrator User MGMT 14:49 2017-03-30
1 Available °
Run Test
USER USER OPTIONS
administrator > e
technician > e
F i
labuser > B
User Active @
Options

Assign user profile >

Assign Assays >

®

Accav Qtatictine S Log Out

E] save ® cancel

20 Add user

E 48 EFMEHR .

3. AR FR B G DL R R I
O User Name (FIfF4) : RArEER 4.
O Password (Zfi%) : FSVFHE KL 2D
O User Active (yes/no) (BT [R//B]D « RWESH P RERE. RS EBAE
BIREE R G FHATAT TR
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O Assign User Profile (/ECH P ECE SO « SRVFAZH P S ECORE M P ECE SO (i,
Administrator [ # 51]. Laboratory Supervisor [S246= 341, Advanced User [&1Z¢f F]-
Basic User [FEAR D o MAE XA M FRIEFEEKH P IE S (B49) .

administrator User MGMT 12:03 2017-07-03
—I Available °
Run Test
USER USER OPTIONS USER PROFILE
administrator > Administrator e
technician > —— Laboratory Supe... View
ppan D> eeeseens Advanced User = Results
User Active G Basic User
Assign user profile > Service Technician Options
Assign Assays >
Assay Statistics > @
Log Out
20 Adduser ] save ® cancel
Bl 49 8K P 4R P B E A .

O Assign Assays (ZPECASIND « W A SEVFEAT ARSI s e rh o SR . P2 IX380A
Mz hEEAE I (B 50) .

administrator User MGMT 14:49 2017-03-30
—I Available °
Run Test
USER USER OPTIONS ASSAYS
administrator > Resp Panel a ) e
technician > — View
labuser > femilta

User Active @

Assign user profile >

(]

2
z
3
@

Assign Assays >

Assay Statistics >
Log Out
20 adduser

E] save ® cancel
& 509K P43 Al
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O Assay Statistics (RZETH4dE) « SoRpTiE A @ Tk (E 510 .

administrator User MGMT 14:50 2017-03-30
—I Available °
Run Test
USER USER OPTIONS ASSAY STATISTICS
administrator > Resp Panel e
technician > — 5 Vi
labuser > Goaiits
User Active @ ; @
Assign user profile > Sptions
Assign Assays >
Assay Statistics > @
Log Out
20 adduser E] save ® cancel
B 51 EERNZHBEE.

4. ¥%F Save (fff7) IF Confirm (Hfiih) fRAFEM. Jb4h, WATH T Cancel (HUH)
Confirm (H#ih) A .

6.5.2 WA/

1B UL N 25984 QlAstat-Dx Analyzer 1.0 7R In#ET A/

1. ¥#F Options GEIH) %4, SRJ/5#%F User Management (FH /& H) IR4KICEH /. 2R
BRI A X 2 T User Management (5 HE) FREE (K 52) .

administrator User MGMT 17:23 2017-03-30
—I Available °
Run Test
USER USER OPTIONS
administrator > er Name e
technician > Vi
labuser > o B
>
User Active @
Options
Assign user profile >
s (O
> Log Out
20 addUser E] save ® cancel
B 52 B .

2. WFBREL T A Add User GRINFFD SRARGRINE A .
3. Ad RS S N\ 5T FH 2 I User Name (FH /2 44) il Password (#579)
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4. 3% Assign User Profile (4FECHPECE SCH) 35 OANAFEXIBAMBIR) A#H P 2 EiE 1

R BCESCHE (K 53) .

administrator User MGMT 17:25 2017-03-30
—] Available °
Run Test
USER USER OPTIONS USER PROFILE
administrator > User Nam Administrator e
i newUser
technician > Laboratory Supe... View
Bagson
labuser > Advanced User festlts
> Basic User 2
User Active @
Service Technician Options
Assign user profile >
s O
> Log Out
20 adduser E] save ® cancel
& 53 9% F 2B P R B SO

5. ¥ Assign Assays (ZHBECRRND 3 (AR BB IZIFR D) EH8E aveF P47 R .

6. % T Save (fRf¥) Jf Confirm (k) DRAFAERERERE . B CaBE S, AL

B3 QlAstat-Dx Analyzer 1.0 T

6.6 A B
£ Assay Management CRrllE 2D gy, w1 DUE BATIIAN U7 AR AH DG 15 B X Ge vt 4l

#R: Assay Management CHillE B 3% WA E H T4 “ Administrator 7 (& 3
“Laboratory Supervisor” (SEIR=E 38D BB A .

I

)

i
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6.6.1 ¥ KR

I UL B R B QlAstat-Dx Analyzer 1.0 b A& .

1. % F Options I %4, SRJ51% F Assay Management R L) %4118 Assay
Management CRrillE ) BFEFE. WAXIRPIE—F 25 BTk (B 54) .

administrator Assay MGMT 14:50 2017-03-30
—I Available °
Run Test
AVAILABLE ASSAYS 08437015450506
Resp Panel > Assayactive @& e
Assay View
08437015450506 Results
Hespwato.ry Panel @
{‘0 Y Options
Assay Notes >
Type of Samples > @
Log Out
[& import ® cancel
& 54. R A R

2. FENEE XA MBI b 2T S B AR £ 44 K
3. EFE 6 KL .

# 6 RWETER

I

L

Assay Active Rl

Assay ID (il ID)

Assay Description (Rl )
Assay Version CRll A< )

LIS assay name (LIS il 42 #%)
Assay Notes CRllERE)

Type of Samples (FEAT )
List of Analytes (#4514
List of Controls (X H# 5114

Assay Statistics CH il 4 447 )

2T UK T B0 B i sl A PR A

Won: WERENDHMAEIRES, U R B E KL I QlAstatDx Al .
S IRA S .

SR A5

SRR A -

RASET US BIfE .

PRI E At AR5 S

SRPAISCRE I S AR AR5

FRALAIN B H 2R ST 51 2K

SR b A F X R S TR B 2

$2fit QlAstat-Dx Analyzer 1.0 Al (MRIZ 1T k%, CAKBATE. BAPE. R
SN e
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6.6.2 SN

j:,l,

=Y

T LT #2380 QlAstat-Dx Analyzer 1.0 S AHA& -

C BAE R RARIE SR USB i % 4f A QlAstat-Dx Analyzer 1.0 ] USB i [,
. INEDEERS IS QlAstat-Dx Analyzer 1.0, i%#% T Options (iEI) %4, SRJ51# K Assay

Management CRRMIEED #5240, BoRBFI N2 X84 HIL Assay Management CREIEE 2D
hi: (B 55) .

scrmrisirata sy MEMT ________11s1si0is

T svaiatie 2 vaintia 3 vatie A peaiatie °

AVAILABLE ASSAYS Assay0l Pun Test
Assay0l > Assay Active P ~]
Respiratary >
00000000000001 e
English description Ll
1.0
LIS assay name >
Assay Notes > iins
Type of Samples >
List of Analytes >
List of Controls >
Assay Statistics > Leg Qut

B Bl e ® conce

& 55.Assay Management GRMIEH) RH.

3. W NREELETMAN Import (A EFx.

M USB 77l e ik £ 5 R SR A BRI 52 SO0 O 7 ik RGERT ARG, RSO
e HR b A AN 5 S

- BB HIL—AFT A SO B AR IR AE .
ORIR—ME R BTRASE S5 A AT RS N IERE . 2 yes (&) .
. 1EFE Assay Active CREIINEGED Bumkl (& 56) .

AVAILABLE ASSAYS Assay0l Fun Test
Assay0l ’ Assay Active
Respiratory >

0000000000000 e

English description n‘;‘i’,’“
1.0

LIS assay name > e
Assay Notes > il
Type of Samples >

List of Analytes >

List of Controls >

Assay Statisties > Log Out

[ mpon B sove @) cancel

56 BER .
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6.7 HC#E QlAstat-Dx Analyzer 1.0

7£ System Configuration (RZACE) KHF, W LIEH QlAstat-Dx Analyzer 1.0 RZiAIE X IX

WRFE S
6.7.1 XIHiEHE

I DL B34 QlAstat-Dx Analyzer 1.0 fit & X% & :

1. ¥~ Options GETD %4, #8514 T System Configuration (RZEELE)D 44
2. WEMBIHE Settings (BE) #IF ik Regional (XIR) . HRIEFHERIFEIFE R 7

IR E.
R 7T HNXREE
wE L]
Date ( H3) EXRGHM GE. AL B) CFHEE 57)
Time (I i) TESURGTE CEE L 4350
Time Zone (I [X) JE XL RGN X
Date format ( F jii#% %) & X AR, AL AT AES CF—T1E 58)
DD-MM-YYYY
DD-MM-YY
MM-DD-YYYY
YYYY-MM-DD (ERik)
YY-MM-DD

Date separator (HAFaF) & X HMZBERF. ALL Tl HEEED CF—7E 59)

“« »

“« _ o« (%ﬁi«)\)
“pr
Time format (a3 &SR A . A LR AT R CF—T0E 60D -

24 /NEF (hh:mmiss) (ERIAD
12 /B (hh:mm:ss a.m./p.m.)

Language (if7) HEE (BRI
administrator System Config 14:51 2017-03-30
—l Available °
Run Test
SETTINGS REGIONAL SETTINGS DATE
Regional > Date > e
General >4 Time > ° ° ° Vs
Printer > Time Zone > 17 03 30 Lot
Network > Date Format > °
System Log > Date Separator > Options
Technical Log > Time Format >
Version Info > Language > @
e S > Log Out
® cancel
B 57 R BRGHM.
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administrator

_I Available
SETTINGS
Regional >
General
Printer
Network
System Log
Technical Log

Version Info

Bl 58 BB ARG HHIHER.

administrator

] Available
SETTINGS
Regional >
General
Printer
Network

>

>

>
System Log >
Technical Log >
>

Version Info

B 59. B RGEHH R

administrator

-l Available
SETTINGS
Regional >
General

Printer

System Log

>4

>
Network >
>
Technical Log >
>

Version Info

& 60. B RGN R

System Config

REGIONAL SETTINGS

Date >
Time >
Time Zone >
Date Format >

Date Separator >
Time Format >

Language >

System Config

REGIONAL SETTINGS

Date >
Time >
Time Zone >
Date Format >
Date Separator >
Time Format >
Language >

System Config

REGIONAL SETTINGS

Date >
Time >
Time Zone >

v

Date Format

Date Separator >

Time Format >

Language >

14:52 2017-03-30

Run Test
DATE FORMAT
DD-MM-YYYY e
DD-MM-YY :

View

MM-DD-YYYY
YYYY-MM-DD &
YY-MM-DD

5 <} o
@@ g’@ £
o S €
S @ @

E] save ® cancel

14:52 2017-03-30

Run Test
DATE SEPARATOR
2017.03.30 e
2017-03-30 v St
2017_03_30
2017/03/30
2017:03:30

g o o
a 2 2
o o e
S 2 @

_fc_’] Save ® Cancel

14:52 2017-03-30

Run Test
TIME FORMAT

24 hours v

12 hours (am/pm) View

Results

©

Options

Log Out

[E] save ® cancel
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6.7.2 HWHMIKE

B LU B R B QlAstat-Dx Analyzer 1.0 () H X E :

1. ¥%F Options GETD %41, #RJ51% F System Configuration (RZFE) #4401

2. MWEMZ|) Settings (R E) #IFE ik General CGHEHD . WIE T EikFEIFE X5E 8
H R I

® 8 THKERRE

®E

VA

User Access
Control (il
D

Automatic log-off
time C(HZhEHST
[E])

Require password
before executing
assay CHAT R T
L)

Use Patient ID (i
&35 1D)

Prefer Patient ID
Bar Code (i
EADE 20

Patient ID
mandatory (3
ID AT

Sample ID
mandatory (FfA<
ID A BT

JA H User Access Control (FH oIzl , ERFrAE 8% &545, 7 H AT HAH P BCE
SCAERVEIIERAE o

WARZIETAR S, K IEX M BrE AP B, SRR Administrator 35D e E
AFIEAT—FE .

R TRER A JE -

HRATER T User Access Control (I sl #iil) B, Z0E A S iiih . 1% E e LT A
QIlAstat-Dx Analyzer 1.0 A3 H 2 Fl SN T E 248 RGBS R EBE . SRVyaEDl 5 4
BpZE 99 /i 59 4. BRIN: 30 Srh.

BN (Inetsfesh. Jebridi. #RANE A LISk bS5 ) K2 EE [ AR
8]

WRAE RN, P EamAN TR (Flin, 7E Run Test [BATMRA] BEserf) , N L4 4
HATERH T User Access Control (R Uil #il) B, 1ZETA &8s . $imEE, e
F /4% Confirm CifrA) 354 5 #6 75 B4 N 60 A RESAT R«

Use Patient ID (fi &3 ID) ¥l /G, 7EMESSITINAR, QIAstatDx 4G & 8 F HE 4t A
Patient ID (&4 ID) skiA# Patient ID (FR ID) (KL GEZRE 5.3 31

T o S HERH  E Jef F 2 RS S 384 Patient ID (R # ID) .

#Ri\: Disabled (T25H) .

RAEFERAT Use Patient ID (&4 ID) I, kT4 2¥0E. Bif/E, AN HZEE SRR
# 1D, BRIGABEHATHLM . AR, W7 AT O R 1D Bl B

ZRiN: Disabled (22H]) .
Wik lE, HPHEEE KA Sample ID (BEA D) , ARJEA REPATIEI . Wi ARBE, WA AT

LL¥ Sample ID (FEAS ID) #idls 7 BE¥ 4%, QlAstat-Dx Analyzer 1.0 4> H zh4 liME— (1) Sample
ID (F£A D) &

ZRik: Disabled (Z25H]) .
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(F8 4

wE 1t 85

Prefer Sample ID T A T 3R FH P 1 e A8 F A TR IR L 28493 Sample ID (FEA ID) .

Bar Code CHIEFF  gryi. Disabled (EAEFD .

A D & TERS)

Exclude modules A LUK AR A2 1 4 BB RR AR IEZEB AT HO RSk . S SR PR BEAE B B e, Ik ShBB ARG
CHERRELED Bi\: Disabled (B4 .

Number of results A% X T View Results (BFHLER) Frse b 78R 045 AR .

per page (R4t

RHE

Show Previously RAELE T User Access Control (P il 4&iil) I, ZiETiA <iis. ZWEBEHE, &7
Logged-in User IDs  E3kBi%E 1 RN BB R 10511 .

(BAZHMERN  wi). Enabled (B

/1D

Require password R {EJS T User Access Control CFil %) B, 24 es. SwEEME, g
to log in (#HE % P LA N A Re k. 2EHJE, N User ID (7 ID) RIW & 3%,

A g Bik: Enabled (B .

Restore factory ALK R G E EONETA BRI BEE .

default C(PREH
BRIAMED

il

6.7.3 FTEIHL&E

W Printer (FTERHL) WEIED, 7 LUEFERFITEHL. QlAstatDx Analyzer 1.0 Fo ¥ FH X 4%
FTENHLEE 13 2% 15 T (49 USB 3 113 12 S B RS B R 4T EAL

IR DL B B 5L QlAstat-Dx Analyzer 1.0 (FTEINLK & -

1. ¥%F Options GEIT) %41, #RJ51% ~ System Configuration (RAME) %4,
2. WAEMB 1 B 5 g Printer GTEIHL)
3. MATFHATERHLAIR I BT EDHL (B 61D

administrator System Config 12:02 20170703
[ =1
. (>
Run Test

SETTINGS SELECT A PRINTER
Regional > PRINTER v e
General > T
Printer > Eeie
Network >
System Log > Options

Technical Log >

Version Info >

®

2 tottone > Log Out

® cancel
B 6L.ILFERZEITEHL.
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6.7.4 EL USB Z3E4TEINL
YR TH B BR8P USB 422 4T EIML

1. fdFH USB £ NFTEIMLIE B BB ERIEL Y USB 35 1. 4 4 A USB 3 A LS. 1 ANTEf o
FAM, 3 AEAEE RN

2. JETEBETR M PRINTER (FTEIHL) &Iz 3% 5% 11.1 FRTIARIRE 2 CUPS IRshiR)F, 1F
Printer (}TEIHL) & T g FAFTEIHL.

6.7.5 I PLKI 2235 4T EAL
TR T 25 B DA I3 22 2 I 28 T BT L -

1. KT ENLE SR LUK 26 34T T BT pL

2. Bk 11.1 hRER R 4% 228 CUPS IKENFE T
3. XM QlAstat-Dx Analyzer 1.0 J5 4T JFLLE 3 .
4

. ] Printer CHTENHL) 31 E #6387 1w L TR FHATEIHL (22 M4TENRL) » JR)5 4% Save
(RAED &

6.7.6 MBKEE

i Network (%) I AT LK QlAstat-Dx Analyzer 1.0 ZE:EIMZ . U 1056 M FIFT ERALANE
2 HIS/LIS. ARy iic B W45 & B I TEAE S, WHIRAMKEIR.

LT D BORE M 2% 1

1. ¥%F Options G %41, #RJ51% ~ System Configuration (RAME) %4,
2. WAMBI B SR iR Network (%) (] 62) &

administrator System Config 11:50 2017-07-03
1 Available °
Run Test
SETTINGS NETWORK SETTINGS IPv4 SETTINGS
Regional > Enable IPV6 ( Obtain IPv4 &
" ! D address autom, -
General > S View
Printer > Results
Enable IPv4
Network > e
IPv4 Settings >
System Log > Options
Technical Log >
>
Version Info > @
Enable CUPS | Obtain DNS o7
nable » ain &7 ot
E] seve ® cancel
H 62 EM%E.

3. MREE M2 B R AR R IE R AE (R 9 CF—T0) LI IEI.
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®OMEBE

IR

VA

Enable IPv6 (3 IPv6)

Obtain IPv6 address
automatically ( H Z3REL
IPv6 Hthik)

IPv6 Address (IPv6 Hiulik)

Subnet Prefix Length (-7
GIESSED)

Enable IPv4 (JaH] IPv4)

Obtain IPv4 address
automatically ([ #3kHL
IPv4 hifik)

IPv4 Address (IPv4 Hiulik)

Subnet Mask (-7~ fi 65 )

Default Gateway
(€ VNP

Obtain DNS address
automatically ¢ [ Zh3KHL
DNS #hfik)

Preferred DNS Server (1§
1% DNS %545

Alternate DNS Server (#
DNS 45 #5)

JEH 1Pv6 WM . TSR IPV6 Settings (IPv6 &) fUEJSH T “Enable IPv6”
(T IPv6) IS .«

FVFR E L DHCP MMIZS 3R IPv6 Hidik.

5 SCF 2 e B B ERLEL IPv6 Hihik. 1ZIETNAE “Obtain IPv6 address automatically ”
CHBNREL IPv6 Huhik) 4% P S o

FE S IPV6 T ETZRKC . 1ZIET{AE “Obtain IPv6 address automatically”  ( F 3h3kEL
IPV6 Hidik) 5T -

JA R IPvA BREOE . 7325 IPv4 Settings (IPv4 % E) {XFESH T “Enable IPv4”
B IPv4) N0 -

Fovrds Eimid DHCP M4 FREL IPv4 Mk

FE SCFBNC B MR IPv4 Hihl. ZETUNAE “Obtain IPv4 address automatically ”
CHBIERAL IPv4 Hhb) 25 AR o

FE X IPv4A FRIRTRKE . ZEI{AE “Obtain IPv4 address automatically” ([ zh3KEL
1Pv4 bk %% A B U0

HLAE 5 F L TUE X IPvE B IPv4 BRINIM G . iZIETUXAE “Obtain IPv6 address
automatically” (HZh3REL IPv6 Hihik) 5§ “Obtain IPv4 address automatically” (3
FRAL IPv4 HihiE) 2 TR0 -

FVrdE Bt DHCP MM 45 3RH DNS At .

FE CETE DNS R4 8%, %A “Obtain DNS address automatically”  ( E #)3KHL
DNS Hihil-) %% FH B I

5E L% 1 DNS IR % 2%, 1% Ti{L/E “Obtain DNS address automatically” ([ 3)3REL
DNS Hlitik) &5 I

6.7.7 HIS/LS &E

6.7.8 RgiHE

ARG H EWF T ERAER BB A S — AR AS B, B s sl bR A S S A
Bk, VER. MRITAR%E. #% T Options GEBD %41, 4851 T System Configuration (RZEHC
B %l BJE#T System Log (REGHE) WA AZGHERE. HERNERKNFERER S
D23 iEoR System Log Capacity (RGIHERE) - % F Export Log File (FHHAEMH) WS
HHE CF—TE 63) .
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administrator System Config 14153 2017-03-30

1 Available °
Run Test
SETTINGS SYSTEM LOG
Regional > yst pacty
100 Mb Refresh
General > -
View
Printer > pantilts
Network >
System Log > " . Options
Technical Log >
Version Info > Page 1 of 163 s 3 @
= PR Y . Log Out
B exportLogFile
B 63 HRGHE.

6.7.9 FARHE

FARH &L T A RS AT AR DGE G B . %G B4t QIAGEN HAM S H Ti#t47T
MR HERR . 2 N Options GETD %41, $RJ54% F System Configuration (RGREE) %4, &5
% Technical Log (FAHZE) RTHFEAHERFL. TURERAHEFRTHXHENEE. &
ANH B pE B S H AR 4T R 5. #% K Export Log File (FHHEMH) LS HAE
(K 64) . QIAGEN FARMRS AT e ERIBHEEOAR H &

administrator System Config 12:03 20170703
—] Available °
Run Test
SETTINGS TECHNICAL LOG
Printer > 10 e
Network > View
2017 Results
System Log >
Technical Log >
5 Options
Version Info >

System Update >

®

System Backup >
Log Out

B 64 ViR B .
6.7.10 RAFE

% T Options (T %4, SRJ54% T System Configuration (RS E) %4, HEHT
Version Info RAMEE) T EE QlAstat-Dx BFHFETFHAENRA . T35 Wi s ity 515 Fi & 4
&N
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6.7.11 RGFH

BN R 1.1 sUE SRR A RE SR B RCA 1.2,

JRIE B AEERE, E SN R R A . HHER TR E M HE D, wiEd
support.giagen.com B & QIAGEN £ A% .

WMEFEH QlAstatDx Analyzer 1.0 # %, #% F Options (ETi) %4, 4R/54# ~ System
Configuration (REMCHE) %4, H&/5i% F System Update (RAEH) . #4F USB k4 L
FREMAER dup SUHERERGEER B HRA . SER—ZHE, BBUERITRES N
(3% 6.7.12 7 (H 65 . BHfE, "R ZRAFKE QlAstatDx Analyzer 1.0 F:7
V=EIP

Making a backup is
recommended before
updating

© eroceed ® cancel

B 65T REEH -

6.7.12 RGN

WE & QlAstatDx Analyzer 1.0 %%, #% § Options (iETi) #%4H, A5+ System
Configuration (R4 E) #4H, H)5#% T System Backup (RZi&4) (& 66) . ¥ USB #7
il Yo £ 4 A IETHI ) USB i F1

‘‘‘‘‘‘‘‘‘‘‘ &ysem Ganfig
| st 2 waitie 3 maiatia 4 nrsise ()
SETTINGS BACKUP R st
Regional > Make Backup >
HISILIS > Restore Backup »
neral > (=]
View
nter 4 Results
ter >
>
, ©
Optiors
>

B 66 3T RGEEA -
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T Make Backup (ZEfl# ) #2H. HoEABRASCIEA AR — o 408 .dbk IISCHF

INELE )R %4y, W1 T Restore Backup GRER#43) 24, X5 MIEHER) USB Rl it s Lk #%4
JE4 08 .dbk HIAHRL AR S R Ml — 2R, BWEAEIE AT BT %40

6.8 HUUHY
W O 05, 154 R Options GETID #4411, #RJG#% F Change Password (CE{(ZE)

HIRTE AT B RN ST (B 67) , SRJETE New Password CGEr&id) FBh i NHTa469 .
7f Confirm Password (NS FEF BN ZE (K 68) .

labuser Change Password 17:37 2017-03-30

User ID labuser Password

q w e r t y u 1 (¢} p
a s d f g h j k |
4 z X c v b n m <&l 123
X space v
B 67 SN\ LI EE.
Jabuser Change Password 17:37 2017:03:30
New password Confirm password
1 2 3 4 5 6 7 8 9 0
/ ( ) € & @
0 ? [ <& ABC
X space v
& 68 M NFHINETHE.

SURNERIEL S, HEMATBRESEH -2, FHSER—AXEE, Hh EoR
“password failed, please wait 1 minute to try it again” CEIJM, H&H4 1 208, RFEER)
S
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6.9 QIAstatDx Analyzer 1.0 RGEIRA
BRI W RSB 1T QlAstat-Dx Analyzer 1.0 IETH PR ASTERAT (LED) MISiE =,
PRI B R DL MR BORES Si

# 10 fifRe T A BE S AERAE AN 3 MR b RO APIRAS T

£ 10.RSIT UMW

Btk RENT YL

AR K QIAstat-Dx Analyzer 1.0 B34
e QIAstat-Dx Analyzer 1.0 4T RHLE
ey QIAstatDx Analyzer 1.0 IEfEi&4T

S K QIAstat-Dx Analyzer 1.0 £.5¢H4]
Wt QlAstat-Dx Analyzer 1.0 4bTAHLR
St (R QIAstat-Dx Analyzer 1.0 1IE/EHIZG1L
g IR IELE B AT
EAREN I AT

6.10 %] QlAstat-Dx Analyzer 1.0

QlAstatDx Analyzer 1.0 RefigFFEHz1T. WREHIE CARB—FR) AMEMAZEE, BAEBCEL
R A IEHIE 47 1E QIAstat-Dx Analyzer 1.0 #EABHIBIE . T K )56 QlAstat-Dx
Analyzer 1.0, #5514 QlAstat-Dx Analyzer 1.0 15T ) FEIEIT .

WA P 2R IE WS IEFE B AT MM E QlAstat-Dx Analyzer 1.0 HEARHLER, M4 ER
—/NIHEHE, R EHMWEEFNL. i RGEERMRIET, 2Rl M .
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7 HIS/LUS &gk

AHNET QlAstat-Dx Analyzer 1.0 5 HIS/LIS M.

HIS/LIS Fit & nJ LLik QlAstat-Dx Analyzer 1.0 #%E#:3] HIS/LIS, f2At&FhThas, #ilin.

BUEFELE S HIS/US MilfE
RNECE, H T RIE S RS LAE
o RE TAEHIEAT I

RIEM R LR

A HOEFIEE 5 HIS/US FiEfE

\l

[

. 1% F Options GEIR) %4, #RJ51% K System Configuration (RZRCE) 1%4l.

. MBI Settings (BB FIR LR HIS/LS (KRG R ARG/ LR EEERG) o R
i B E SR 11 A i E CF—30) -

N
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£ 11.HIS/LS $ &

w"E PiHA
Host Communication JaH HIS/US & .
CEALES SRR NS

Host Settings
(EHBEED

Result Upload
(B AR

Results Upload Settings
(G5 R EAERE)

Test Orders (JIlt#)

Order Settings
(CLARERRED

RA7EE A T Host Communicator (EHLE(E) I, kT4 SB0E. %5 E E LT BRI
EHLE . ENUHEE R PR BN 1P FIAFRME. P ELFHE 4 NCE (NLNLNLN), N SZITE
0 % 255 2],

FERTHMY H ATAEZS HI7 CRRRRAIESHZE POCTIA) .
R FRRAMA 4 FK, HIF € X DMS 5 LIS,

N ERARCE N 5 F2, HZ ] IEK ] 60 #b. X2 QlAstatDx Analyzer 1.0 54F FEHLIH B
K]

B BA BRI S22 BAG R AR AR )V S R A -
WEPREBARA, RIS R 1P A FEHE QlAstatDx Analyzer 1.0 5 EALAIEIE .

Ja 45 B QlAstat-Dx Analyzer 1.0 &% ZIEHLAITIAE.
PRI TR NEEF .
RAELEJEFH T Result Upload (455 FA%) I, iZIETA S30E .

SER AT DRI BRI SE R, BN EBIRITFS). 5 A, WASE s B S 45 R 1%
F|EHL. 2 AN, FTRI% T Result Summary (45 5845%) M View Results (FHSEH)
ST Upload (AR #Z41RFahAikgs K. BRINEEEH B3I .

Expire Time CH 204D 2R LR Z R =N REL. RENTN, 2T, 458K
AT A S o

Reset Uploading (E & F4%) ] LAE SR RIEMMH BKAZ]. WREAERIET ZANER, HE
HH TR S PR O AL S, I IR .

Retry (FEif) A AEHi AR LARIRES A “Error”  (BE2) 4R

ALK f €L E D Authorization (B2A0) , BME_LAEZE R . BRI UG8 8 53 A € ) T %30
HAE HIS/US FrBI i TAESS FB AT IR DR .

UL TTER DA 2%

HAELESS AT Test Orders GUIRAL) B, ZIEIA 285

Force Order (3| TAE) 7T LUS IS4 I, BI6E S ENREE D, B0%E SMARIEEA ID
AT AE . Force Order (BRI AR MIERINEEH o

7.2 AR E

HIS/LIS T BRI & FR T BE 5 QIAstat-Dx Analyzer 1.0 o R R I & FR AR . 46 H HIS/LIS
THRERT, WZHAT LR IRFRH N/ B IR T 4 FR o

1. % F Options I %41, SRJ51% T Assay Management R ) %4118 Assay
Management (FEIEFHL) BE%E. W2 XIS —F1 451 H AT H Al .

2. M Available Assays (] IS 2 5k B4

3. %EF LIS assay name (LIS Bl B #5%) 0. BIAEM T, QlAstatDx Analyzer 1.0 5
HIS/UIS FIR I A2 FRBAHR . 4 HIS/ZLS s AT ZARANE, I 2Rk T A IELL S QlAstat:
Dx Analyzer 1.0 fJll 2 F%—%. A LIS will & MR N SCAF B BRI 2R, 2RJ51#% Save

(BRFE) .
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7.3 EPVEREAE I Bl

J& Fl Host Communication (EHLESS) 1 Test Orders (A ER) J&, TTLLN TN FEMNRE, R
JaRis4T .

P B AFEA ID 2 B3I PSRN
7.3.1 {FHFENIEEMAE QlAstatDx Analyzer 1.0

1. ¥~ Options GEID %4, #RJ54% T System Configuration (REECE) 1%4l.
2. MZEMFIH Settings (BB FIFhiESE HIS/US (EREERG/LHREEERLS .

3. JA F Host Communication (EHLEE) FHEHENLVEGE SR E Host Settings (EHLEE)
% Check connectivity (i AR 4IHINER: .

4. B Test Orders (JREL) JHCE Order Settings ( TAEBAE) . i LR B B A WA,

J& FH 25 Force Order (3| TAEBR) #35. J3 A Force Order (3| THES) W, dnfik

MENL IR R B, WP ik gk sz 7. 451 Force Order (i TAEH) W,

RIME AR R BN ol BN P AR AN B, P O k8T I, AR &3l i &
EDAR

7.3.2  ARHEIEL RIS AT I

1. HeFEpss s © Run Test GBI He40.,
2. WIURRIG, 10 R MR b b S B 1 4% TR D S R A 1D 44060 (1 69) .

o MR4E QlAstat-Dx Analyzer 1.0 FCE, & nT DAS F Al 7 b 1) i 0L S SR A FEA 1D

HRVER, BESRE 6.7.2 1,

sdministrster Run Test Moduie 2 1423161018
1 administrator ) A
Avsilable Available t Available

TEST DATA

cccccc

Bl 69 .39k 4 1D TG
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3. FEA ID ¥t ki%3| 1ML, QlAstat-Dx Analyzer 1.0 ¥4k, 4R “Getting
order---”  CIEFEZRERMRH-- HE (70 .
PR WURAR M BN R SR, 24 Force Order (B TAEH) RN TS A, U
P Tk 847K, 24 Force Order (B TAEER) HTAEHES, RIEARAGZR MR,
PR (S —AE 0, HPEREEEE) o AREREEMERNE
g5, WE 9.2 5.

administrator Run Test Module 1 12:23 2018-04-05

Ul administrator

TEST DATA

smple 1D
15 v

y Ty 3
i
mple Typs
Cancel
Getting order
B 70 MR W B AR B BoR.

4, NEHBIMERIREE, ¥< B~ “Scan cartridge for assay <assay_name> and book
order <order_number>”  CE#NA <t 2 Fc> A TAE R < TAERmS>HiHE « 3
FiTEE 1K) QlAstat-Dx KA G MM CF—E 71 .

TR A EVUNFEAR ID BEZ A, W< &R “Scan cartridge for book order
<order_number>”  (FI# TAF 8 <TAEH 45> MEliE) HE. WRARK QlAstatDx i
DAFGS TAERAR—2, MRS TRk s, KRB T EREHE . H B4 ES A
ARG R, WA 9.2 7.

administrator Run Test Module 1 12:53 2018-04-05
Ul administrator

TEST DATA

15 v

Cancel
Scan cartridge for assay "Resp" for book order 2342343325

Bl 71.393#% QlAstat-Dx KR & FFHHT
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5. £ HIAT Assay Type CREMIZRAD 7B, MR FIE, NG P& BEAH R ) Sample
Type CHEAZRAD (72

administrator Run Test Module 1 12:43 2018-04-05

JI administrator
Resp Panel

TEST DATA SAMPLE TYPE
ple 1D
15 v Swab

’ utMm
Resp Panel ~

Cancel
Select Sample Type

B 72 EEREARE,

6. % 5.3 WHTEHRPE 5 - 11,

7.4 RIS R AL R AL

J2 M Result Upload (455 4%) I Results Upload Settings (45% &% HE) &, ATULHMET
BB MALE JE EAE S

7.4.1 B E QlAstat-Dx Analyzer 1.0 LA Zh 2 B AL 5] 41

1. #%F Options GETD %4, #RJ/51E T System Configuration (RARE) %4l
2. WAMIBIH Settings (WED FIRHIERE HIS/LS (ERE B ARG/ LREFLERGD -

3. /AH Host Communication (EHLEE) FHEH FEHFEM(E ERE Host Settings (FHLEE) -

% Check connectivity (Rt RN EH.

4. JaH Result Upload (453 F4%) , #R/EHCE Results Upload Settings (453 AL RE) o B H
Automatic upload (Hzh B
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7.4.2 KRR A B BRI AL

MR, BB AR, FEREERIELR Summary (2D FEFER Test Data (Ml
REAE) HBAYA View Results (EELER) FFER) LUpload (EAE) FIF (B 73) .

administrator Summary 12:47 20181218
1 Available °
3 5 Run Test
TEST DATA DiagCORE Respiratory panel
12
© Ccoronavirus HKU1
Assay Type
RP @ Mycoplasma pneumoniae View
Results
mple Type ivocal
ut™ @
Pending Teste Options

© Ccoronavirus HKU1

° Mycoplasma pneumoniae @
B summary |

K. Y " - Log Out
IS Print Report [E] save Report 1, upload

B 73.45% Summary (JHE) FE.

B FAMEAE LS AP T 02 ATIR I A IR, % F R gkt @ View Results (7
FL&H) o N Upload (Ef8) FIBREMERS (B 74) .

administrator Test Results 17:33 2018-04-05
1 Available °
Run Test
@ sample D Assay Operator ID Mod %, Date/Time Result
913 Resp Panel administrator 1 @ 2018-04-05 17:22 @) pos e
8265 Resp Panel administrator 1 @ 201804051720 @ pos View
= Results
Resp Panel administrator 1 @ 201804051657 @ pos
123456 Resp Panel administrator 1 @ 201804051639 @ pos @
77702 Resp Panel administrator 1 20180322 11:42 @) pos BHiohs
77701 Resp Panel administrator 1 2018-03-22 1140 @) pos
Page 1 of 2 > A @
Log Out
J\ Remove Fitte [ Print Report [E] savereport O search T, Upioad

& 74.View Results (BFELER) F¥#.

AREEIR SARRESTE R 12, TERESERT LAEMLS R, Name (45K BRELR
Summary (FH2) Fisrh, EIbRER1E View Results (BHESR) Bt
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#® 12. HEREHIR.

AT Btz L]

Pending (f5E) @ SRMA L.

Uploading C(IEYE_4%) @ GERIETLE 1A%,

Uploaded (timestamp) @ SR CE I LA, B AL FHAI R .
(2 EA% [RAED

Error (451%) @ ARGERIN A GBI, .. o
Re-Uploading (IE7ETE#r bA%) @ IEFEF IR IESE R

Expired (previously uploaded) T bR R . CEBDRINKIE T — K.
(B3 [2Hfe BED

Expired (never uploaded) Tk AL R . IR RI% .

(B AR EAED

7.4.3 [E QlAstat-Dx Analyzer 1.0 PLFEE MRS B _L4E2] F 1

1. #%F Options GELD %4, #R/53% T System Configuration (RAME) %4,
2. WAEMBIH Settings (WED FIRHIERE HIS/US (ERERBRG/TREFLERGD -

3. JAH Host Communication (FHLE(E) HAH EVLFAIE EEE Host Settings (FHKED .
% Check connectivity (i #riZEdett) AN ER,

4. JEH Result Upload (£5% %) , 4RJ5FLE Results Upload Settings (455 FA&E) o ZEH
Automatic upload (Hzh &)

7.4.4 R RT ) BRI TN

WATERSE, FTLAAEE R Summary (F#5) Bi#:E View Results (BHELR) HikFo) BALLER.
EENGER Summary (D) i LiE g, it T D veed Upload (k) Hitl.

A E View Results (AEEER) B EARLR, WATDHL NHEA ID 570 R BORIE S — 1 eli%
ANIREE R o Prif sl R 550K & Bon— N RERRE . & EPUHIEF KGR, L T 2R ER

e BFEATH @ EHein M kAL R FE, BB LN RE, % F T b
Upload ( E4%8) %4l (B 75)
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administrator Test Results 17:33 2018-04-05

_I Available °
Run Test
@ sample D Assay Operator ID Mod %, Date/Time Result
91113 Resp Panel administrator 1 @ 201804051722 @ pos e
Resp Panel administrator @ 201804051720 @ pos View
= Results
Resp Panel administrator 1 @ 201804051657 @ pos
Resp Panel administrator @ 201804051639 @ pos e
Resp Panel administrator 1 2018-03-22 11:42 @) pos REge
77701 Resp Panel administrator 1 2018-03-22 11:40 @) pos
Page 1of 2 > A
= Log Out
I Print Report [E] save Report £ search 2, upload

& 75.View Results (AEZER) R#.

7.5 HEEREHLER S

TIHERR EHLE R, TE LA 9.1 1Y,
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8 4

KA T QlAstat-Dx Analyzer 1.0 i i 4EY £ 55 .

8.1 #Prs%

2 13 R4 T BN QlAstat-Dx Analyzer 1.0 $AT 4L 1%

£ 13 EFELHR
£% gk
X QlAstat-Dx Analyzer 1.0 RI#AT  WIABA, M MmEVEMRA CrTRERA G k3 QlAstatDx Analyzer
L SNE] 1.0 #ifi b, EPITIHZES
ik St huR). FEFEHAT — K

8.2 &% QlAstat-Dx Analyzer 1.0 i

A

/BT | A SO EAHEHRER%
é TR, WY BT R T E LR, DU R AL
BEIER | A\ BG5ERARSE RS

TEERT, i QlAstat-Dx Analyzer 1.0 5 HEH FEKIIT .

L)

A

QIAstat-Dx Analyzer 1.0 $23F XU k&
T G Ak 2 B AR AR IR N B Y QIAstat-Dx Analyzer 1.0. Bl AA Ik i it
B4R A RAE T2

&

A

QIAstat-Dx Analyzer 1.0 $23F XU k&
TR G 5 YA T ) ok 4 R B FL SRR . W EE VA B B, E R QlAstat-Dx
Analyzer 1.0 FfiFft#) bR A 47
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{EF LA 20 8hiE 7 QlAstat-Dx Analyzer 1.0 K :

o AR

R LU BB QlAstat-Dx Analyzer 1.0 KT :

1. B SR EFEMY HE, FELRR.

2. FRAALEEFIFHRAC T, REEER QlAstatDx Analyzer 1.0 F T, LUK BN TIEE XK.

TR, AEFRMBSE. MBS MG, M QlAstatDx Analyzer 1.0 B} i 57 % 4%

ATHEAT

3. AT EREPATEE 2 =K.
4. FZEEKFEAT, RIEEH QlAstatDx Analyzer 1.0 i, LAMWEIR B BE . EEMH

/e

5. P48 T QlAstatDx Analyzer 1.0 1.

8.3 QIAstat-Dx Analyzer 1.0 275

BEIE

A

N B 05 EAAF R XU
TN, H B BRI FEIRFE RS, DO R G .

TR A 20 MR A B AR, ATRESREUE R iR (D« FHEEAUIAD
INVER &S

B/

A

PN Vik vtk p ke N
EERT, i QlAstat-Dx Analyzer 1.0 5 Y5 FEKTIT .

&

A

QIAstat-Dx Analyzer 1.0 $33F X k&
BG4k 2 T A AR IR N BT Y QIAstat-Dx Analyzer 1.0. RV M &
R AE ARABTE R
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e QlAstat-Dx Analyzer 1.0 3R XU
TEE K VRAZS W 3G ) o 5 0K L SRR . W EEVE AR, B E QlAstat-Dx
A Analyzer 1.0 KB H 5 HE oA 34T -

LA R85t QlAstat-Dx Analyzer 1.0 R iEAT £V 4L FH

o 10% EHAFE
o 4Lih

o JEIK
R LR BB QlAstat-Dx Analyzer 1.0 R #7275 40H :

1. B EERETEMPHE, FELRIR.

2. FH 10% EEFERTHEAR D, REER QlAstat-Dx Analyzer 1.0 £, LARHEMLES
X HEE, AEFRMBER. 205/ =04%, IHEORERSE 375 RN .

3. H—RIHMTE.

4. AN SE 2 1 3 HEEHITHIR.

5. FHZEMUKFERAN, R5HE QlAstat-Dx Analyzer 1.0 #ifi, AP PRI & HIE G 7K. B
SR

6. i HF 4T QlAstatDx Analyzer 1.0 1.

8.4 HHr il JEds

AR T — R UL E AR, DA R B A 2 R R G 2
20 ER AL T QlAstat-Dx Analyzer 1.0 N J7, 7 AEAC#E 15 T B v fir /% .
HAEE I QIAGEN At 2 il yE s A7 S e

TR UL PR e S VB 3

1. 4% MU IET @R 40 QlAstat-Dx Analyzer 1.0 #E ARFHLAR .

2. K TFHHE QlAstat-Dx Analyzer 1.0 1ETHZ g asfil i N J7, HIFHamiAs e B,
3. Rt uEgm b, HAEE RN . B IR i

4. RTINS L A A EL ORI AR S
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5. KA ST e s e S N QlAstat-Dx Analyzer 1.0. %35 B /LB a] ff H .

o QlAstat-Dx Analyzer 1.0 3R XU
HEEHH QIAGEN HIJEZEIRM. i RERAUIEB4 T s SEEEERIK, @&
A SAFRABE LR

8.5 QIAstat-Dx Analyzer 1.0 15

QlAstat-Dx Analyzer 1.0 (&3 Hft i QIAGEN B EMIT. W QlAstat-Dx Analyzer 1.0
BATARIES, EHEHE 9 WHIBAEEBER QIAGEN HAMS .

N S 5 R RS M

WEZ71FTFF QlAstat-Dx Analyzer 1.0 45 . 1713 4EEE%E QlAstat-Dx
yzer 1.0.

A FIIFAP B Y QlAstatDx Analyzer 1.0 FJRESEH /7 Z 4571 QlAstat-Dx
Analyzer 1.0 #iidf, T RIB KRR
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9 HibEHEER

AT TEH] QlAstat-Dx Analyzer 1.0 ] gt IR — L8 [, - DL AW g i Ji R AN A 2R 07 56
A5 O IZAX A . W EEHERR QIAstat-Dx AS I G AR DG ke, 752 1 % B RS 18

.

DR AR B D By, T AEHT T I R S B AR QIAGEN HAR R %

Wxk: support.giagen.com

QlAstatDx Analyzer 1.0 H45TECR QIAGEN FARMRSET, WECFR N FEHT R KD XS 15
HEF R EIE R . R EABT QIAGEN AR SS * S il i vl i .

FERLTE ) QIAGEN AR S5 HR AR, TEHER4F LA T B :

e QlAstat-Dx Analyzer 1.0 J5755 . SR AIRA

o RN CIiEHD

o HRRE IR LRI 8] £
o HERKAEMIR (R BRES B

o HRRIEF, WAIRE

o HENHEIA

R

H o

9.1 MEFFRIEATE

H TR

A R R

BILATEW

The QIAstat-Dx Analyzer 1.0
does not start (QIlAstat-Dx
Analyzer 1.0 K351 .

Analytical Module not
detected (AR I F 53 Hr K
o .

The Analytical Module status
indicator is red () HriHCIR
SN SPSEARCDIN

The touchscreen does not
respond (fiHBE MR o

QIAstat-Dx Analyzer 1.0 % £ HL I
JiE

QIAstat-Dx Analyzer 1.0 15 i f H T
KAATTIF o

QIlAstat-Dx Analyzer 1.0 &b T-#HLIE
e

RIEFESEI T/ RN .

T e o

QlAstat-Dx Analyzer 1.0 4Tl
CREBRITAHEER .

T e o

ik QlAstat-Dx Analyzer 1.0 CLZ&JEHE HE .
$TJT QlAstatDx Analyzer 1.0 i i HELIEITF 5%

1 R4, ik QlAstat-Dx Analyzer 1.0 i H!
FEHUE o

TSR 2 WA 2 IR 4 © 48 I e
.
THIRR QIAGEN HiA MRS

5T A F B R T 14T

R QIAGEN AR RS ¥ .
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iR

) o)

RIAER

Bar code reader does not
scan CELE#TVERHRD «

The QIlAstat-Dx assay
cartridge is stuck inside the
QlAstat-Dx Analyzer 1.0

(QlAstat-Dx Kl 7l &
7E QIlAstat-Dx Analyzer 1.0
LIDER

Lid of the cartridge entrance
port does not open (k&
A TARITID .

The Run Test button is not
active (GZA7 T AW
) .

Assay does not run CHiil A
B17) .

Result upload status is
“Error” (53 BAERPIRES
HCHIRT )

A result cannot be uploaded
(i bAREE R .

Cannot run a test because
there is no test order ([X#:
EER R N T S e |

i) .

HJa FREA 1D & TRTG TR

ZE TR [ 152 85 A7 AERE A AR A 7]
BB -

BB -

W& 7E QlAstat-Dx Analyzer 1.0
W, A% QlAstat-Dx # Il £tk
i, X5 QlAstatDx Analyzer 1.0 A fig
PATHI IR

FHRATH .

PP A IEAT D AL RR -
K7E QlAstatDx Analyzer 1.0 % #46
.

HENRERETE P .
SEUINHBEET <l

EENPIELTHS .

SE5URE B2 .

FEA ID BA MR, HIS/US ¥ B 8 A
7 Force Orders (3 TAE#)

5 US WIERAFE RS, HIS/LS &
JaHY Force Orders G| TAE#) o

TR0 = R A E L PRI E QlAstat:
Dx Analyzer 1.0 H %5 ThEE .

i1 2 QIAGEN A MRS
i1 2 QIAGEN HA MRS

IR QIAGEN HA MRS

Module CHEER) RAFE A AIBEHOR ASHE B B R
“Eject cartridge”  CHEHUIRFIE) CAR. 1 FAE
BIIRASHE, R4 T Eject GlEHD

TR A ) W A5 2 IR A7 B 42 IR A
.

TR S e A E R

e BRI . TEIPR SIS A B AR A
I ZR S0 o 2 A AR E ORI VA
5 B IR B

TR R SL0 S T oA AR GRS A S
B, ZEHKTT LM 60 B, WL EE
NERAR, TR 1 2% P R
BN TR TR RPN 15 S
) fHATIHE . IR QIAGEN HiARMSS

o
I R TG T B AR B BORAG A HIS/ZLIS
T A A R .

EHER LIS HHELR, KA US PRBGZEA D
AR,

TR R SL0 S T A AR H ORAS A B E ML
.

FHEAT MR ARSI, 1545 HIS/UIS % B
FH Force Orders (3B TAFEH) .
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9.2 AR

HR/ES

"
2

2

RIAER

The AM in the slots has
changed (Hifli[1y AM
EED .

Making a backup is

recommended before

updating or restoring (il

TE 57 A S5 AT REAT %

B .

Shutdown not possible.

Please stop all tests and eject

cartridges (JoVERM. 1§15

BT BRI HE )

B .

Free disc space ddd reached

warning or critical level (7]

PR AL 73 1) ddd 15 3% 15 5
I KD o

The system was not shut

down properly last time (£

G L —IRARIEH KD .

Test result with invalid data

found CRILELF IO RCEAR

MRGEH .

Unexpected behavior of AM

nnn (AM nnn HELESMT

M) .

Update data aborted, error

occurred CHET ¥R+ L,
AR o

No backup file found Rk

F&H D !

Assay <assay_id> not

available. Code: 0x400
CRJN <K 1D> ANATH .

fRii%: 0x400)

Assay <assay_name> not
active (il <kl 4 Fx> K
Wi .

Assay <assay_name>
already imported. Code:
0x0304 Chrill <far il 4 Fx>
tEA. fRi%: 0x0304)

Import assay failed; the
assay file is invalid (f:ll 5
NSRRI SCHEERD -
Importing ADF <adf_name>
failed. Code: 0x0305 (F A
<ADF Z7k> R, AR
0x0305)

Login failed (&K !

RGN BB B, B
MR SO A E

AR, R IR, BaRTTRE
2FER. HBITHTREMEIRER

MR IEFEIZ 4TI, QIAstat-Dx Analyzer
1.0 BERHA.

i ZEH QIAGEN HR RS KA & R 5L,
AR INARA I R A5 2 1]

REEPATIRFEARKH . L=
AR REE A E K

U], RIS R

— R R G

3B QlAstat-Dx Analyzer 1.0 I H Bl
AR

AAE USB A7t B 7 38 31 1E A ) 4643 5C
1F .dbk.

K5 QlAstat-Dx AR G ARRKT B )
S\ QlAstatDx Analyzer 1.0.

O A o

Bl e vh AL RIAR R 1D ANRRCA

PNHRIS A 1R

SNHIRL IS R

BFARAE R

Tt e AR . BURGEENRE, RERH
HHATIE.

WA VRZEVGHAT ARG R, AR5 I T

EE Ut A o S W (R SEIES

IHHER QIAGEN HAMRS .

TR AR R THT A3 W HIL TE W G B WA, R
A PSS T TR 1) R YRR DG G PN AR, Bl i T
PRI, W55 6.10 Tk

SR AT QIASstat-Dx A IS 714 7 37 iE 47
Ko QR WA E I, IHKAR
QIAGEN HAARSS

WHEA RS WRNBFE, HFR QAGEN
ES 2 N2

HER QIAGEN HARMRE ¥ .

HEr USB (76 5 4% /e R AFAEZ 0. 1)t
HHEAE, iEHER QIAGEN HAMRS .

FA5I F N\ QIAstatDx Analyzer 1.0 (i £ 54
6.6.2 1) .

BER (SR 6.6.10 )

Kl 2 MR RS T S BAEFTHAE .

T from www.giagen.com Rk T i 52
fFo IR B BUL I, R QIAGEN AR
RSB T

T from www. giagen.com [ T il
o A RUIIREBLBE S, IR QIAGEN HiAR
IRE5ERIT

IR AR S = T A A A
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HR/ES

2

RIAER

Login failed! The user is not
activated (B3R! A
WEHFD .

Login failed! Wrong
Password! (R Hid
LA

Login failed! User
identification does not exist

CEFRM H P RAME R
AFFHE) ©

Passwords are not identical
CEMA—FD !
Invalid Password! Min.
length 6 characters. Max.
length 15 characters.
Allowed characters: 0 - 9,
a-z,A-Z,_, space (&%
TS AT 6 NMFRF.
RRKRE 15 M ERF. falF
M77F: 09, az AZ. _.
T .
Export failed (KD !

USB Device not found (K3
F| USB %) -

Bar code reading failed (%%
TERDSEURID .

Failed to scan bar code (&
HHEEIE .

Test failed, Error:
<error_code> CIUiR 2Kk,
R <ERRRES>) .

User has no right to execute
assay <assay_name>. Code:
0X0402 (H A AT <k
M FR> PR . AT
0x0402)

Cartridge already used (i
FEE&mMm .

Cartridge expired Gl &
[REZSUR: /DR

Different cartridge inserted
GENTAFRFRFE -

Failed to create file (JCi%f)

w3 .

HIS/LIS timeout (HIS/LIS #

[P

FH P #c4E 18H] QlAstat-Dx Analyzer 1.0
TR PR o

NI A R

AR IR RS

I E ARG, P AL AR A AR TR 1

.

TR & 2 A5

SR G HEES R, IR AR .
AAE QlAstat-Dx Analyzer 1.0 &l
USB it % o

SN ) % R

RAERGE P SN E %R B -

AR, LR

R B PAT R AU o

Toid AL 2 /i AL ) QlAstat-Dx
iRl Nnwilr=

A6 QlAstat-Dx ik &, HJ
St RO

A QlAstat-Dx A&l ik & 5 46 65
) S A 1 ) R — B

ek QR S48 S

ACHSFN LIS 2 [] R A R I

TEIE R 00 & £ B SR BOE P G
S 6.5.1 1) .

SUERMNSE RIS, B R—re,
RIEA BEFR SR R WL ER, HHR
S B Gy ok v B R D .

IR 2R R B B S RN IR

LOPNCHIETE AR

WEADT 6 MFFHAME 15 MFERIE
i, HHAGRES RFMFERF: 09, az AZ.

_ THE

HOFERAE . W EAIAEAE, TR QIAGEN
ENIE N
F4 USB 73t % &6\ USB i 1.

THIER QIAGEN AR MRS ¥ .

FIE AT RE TR . AR E R QlAstat-Dx
WRATR £

R AT AR, B R QIAGEN FEAR MRS
SR8 BT QIAstat-Dx K63 751 &5 5 5 S AT
o R FBIIFE, EHR QIAGEN HARKS
IR AHRIE I R .

Al LA User Management (fH 53 FRELIR T
BBR GEZS B 6.5 1) .

FRAFAR 3G 22 AR AL R AL A3 F 3L 1) QIAStat-
Dx fr IS A HT QlAstat-Dx &Il & iz
AT

TeVE TS % QlAstat-Dx MR A& . ARIEAH
AN A FE AR

N5 2% G ) S d R AL R Y QlAstat-Dx 46
MR £

USB 17l 4% A& IEH TAE. 1l 288 AR
USB 771 1% 4%

KA HIS/US & i EHE IS ez fE . g
CiERKME, HHKER QIAGEN HARRE .
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HR/ES

2

RIAER

Results in state "Uploading”
or "Expired" cannot be
uploaded C(iiE FARIRE N
“IEAE EAE” B« 2
EEH) .
The maximum number of
results for upload <num> is
exceed <num> i K455
TEHE <num> C&H
<num>) .
No book order for this
sample Id. Do you want
continue anyway? C(iZFEA
ID VA TAER. 2dk st
2 )
Order not found CR#%F| T
fEH) .

Ordered assay not installed

ORZEEIRAAEND

No connection to HIS/LIS
CRER HIS/US)

T P A E G W 4
HEURAN “Uploading”  C(IEYE I
18w, T bk,

LB B A p ok S AR

LIS AKIRFIFEA 1D (k. Order
Settings (LYEH#E) ¥ Force
Order (3l TR BHE N
“disabled” (225H]) .

LIS AR EFEAS ID AL . Order
Settings ( LAEHBE) ¥4 Force
Order GRFIT/ER) &EN
“enabled” (EREHD .

KTE QlAstat-Dx Analyzer 1.0 #2235l
B P SR A

QlAstat-Dx Analyzer 1.0 A [ 4 #k
5 US RIEHRIN A4 A —BL.

FTEAE HIS LIS 508 B SO SN Al .

KA “Uploading”  (IETE BA%) 52RiE, ATLA
TR EALEE R

BUH B sea R, R ER.

FALGERE, wndksaik, TUZHIxT M 45 RAE LIS
A ILRE I AR A

ToFEBATIR . SIS R E T RE R BT DU TR
BH: LS RAEFEA ID AR, RN BN
FEIERE I

A A

THRLAE HIS/ZUS B 1 LIS Al & 5K

LIS #l QIAstat-Dx Analyzer 1.0 Z [FJEi%E ## HIS/LIS B E H &R ER .

#%.
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1OHAR R

TAeskAfF
LR
R
phidEcs

R
ot

BfmAkE

R

ELREFA M (EMC)

EMC 3R

90 - 264 VAC
50 - 60 Hz

IEC 60320-1 C14 #iJiE
1x8A FERT

15-30° C

20 - 80% AAXHEREE, FEAEE
0-2200 m

%% 4000 lux

0-55° C(32-131° F), HmAMXNEE 85%, kA

4 IEC 61326 A 24

W5 CAAMRYE CISPR 11 A 8T T Wik, dERERET, wEEar=4E]

LTI, R BUZFE O, RIS IR T IR.
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HUBREHE R BE (AR

BBtk
Rf

i
il

IR

&

fem

DyNCEA
USB 11

i 234 mm
i 326 mm
P 517 mm
5 kg

B 153 mm
oy 307 mm
TR : 428 mm
16 kg

1x 10/100 - Base-T LA

1B 14y, 5T 3 4
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11Bf 3

11.1 CUPS FTEINLERBNFE FF 22 3

CUPS CGiliFfl UNIX #TENRZD) &AMt Unix FEHHHUEERZMITEI RS, TLUE QlAstat
Dx Analyzer 1.0 Operational Module fEATEIIR %45, X T Frf  PostScript 1 BB HLANE
PostScript fTE1¥ %, CUPS ¥l PPD (PostScript® Printer Description) JXZIFE/F. QIAstat-Dx
Analyzer 1.0 Operational Module Fil5t43% T PPD IRshARF, (HAJSRNT LL A H w2 SIRshAR
o

Hor: QIAGEN TCiERIEFT A TEINLLE FH T QlAstat-Dx Analyzer 1.0. A &Il (14T ERHL
HIFER, ESRME 11.2.

T UL P BR R T LIRS«

1. 7£ QlAstat-Dx Analyzer 1.0 Operational Module 7 Fif#5 # {4 Options > System Config ~>
Network -> Enable CUPS &Il --> RLACHE --> M4 > J5 ] CUPS) i CUPS, #RJ5 14
Save (fRF7) RIFIEE (BUTIHLMEL A A EH AR .

2. 8 Web WA E 5 CUPS (Rfil: http://10.7.101.38:631/admin)

#7~: W LLE Options > System Config > System log > Enable CUPS --> looking for the field
"application software started” GEIU > RAME > KRG HE > HH CUPS > & “H3EH)
LR FBO TR EIDAE A P il

EHELE R &%

User name (FH/44) : cups-admin

Password (#%f%) . {§/H] QlAstat-Dx Analyzer 1.0 Operational Module N 25 844 th i
Options -> System Config > Network -> CUPS settings G&IH > RAHLE > W% > CUPS
WE) TRt %,

3. i Add printer (AANITEIHL) .

4. MPZE R ] R T EINLA R k4T ERbL, #RJ54% T Continue (4k42) .

5. 1#E Share this printer GEZEIITEIHL , )51 Continue (4k4R) (F—HE 76) .
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= ‘ 3 Add Printer - CUPS 2.0 X | + v

T O] (D) 10.7.101.138:631/2dmin

Administration
Classes

Help

Jobs

Printers

Add Printer

Add Printer
Name: [HP_Officejet_Pro_6230 |
B " (May contain any printable characters except "/, "2", and space)
. _[HP Officejet Pro 6230 |
Description:
(= dable description such 23 "HP Laserlet with Duplexer”)
Location: | ‘

(Human-readable location such as "Lab 1")
Connection: socket://10.7.101.237:9100
Sharing: Share This Printer

CUPS and the CUPS logo are trademarks of Apple Inc_Copyright © 2007-2015 Apple Inc_ All rights reserved.

] 76 3 AT ELBLIERE .

6. NFTEIHLEEATEDHLIRSIRE Y, RJ54% N Add Printer GRINFTEIFL) «
s WHRG AT EOHLA RN FL T, 15 3P 14T AL R 38 SRS AR PP o i SR 57 H ) 3K
SIFEFIIARIER, MM F N PPD SCi#% 30 CUPS 3kzh#2/F, 7E Or Provide a PPD
File (Eifft PPD 3CfF) Bk, SRJ54% T Add Printer (ZRINITERHL) (B 77)

B = | = Add Printer - CUPS 205 X | +

&< = 0O M () 10.7.101.138:631 /admin

CUPS.org

« Home
Administration
Classes

Help

Jobs

* Ponters

Add Printer

Add Printer
Name: HP_Officejet_Pro_6230
Description: HP Officejet Pro 6230
Location:
Connection: socket//10.7.101.237:9100
Sharing: Share This Printer
Make: I{Pl Select Another Make/Manufacturer ‘

HP Color LaserJet Series PCL 6 CUPS (en) ~
HP DesignJet 600 pcl, 1.0 (en)
HP DesignJet 750¢ pcl, 1.0 (en)
HP DesignJet 1050¢ pcl, 1.0 (en)
HP DesignJet 4000 pcl, 1.0 (en)
Model: HP DesignJet T790 pel, 1.0 (en)
HP DesignJet T1100 pcl, 1.0 (en)

HP LaserJet Series PCL 4/5 (en)

HP LaserJet Series PCL 6 CUPS (en) v
Or Provide a PPD File: Examinar..

CUPS and the CUPS logo are trademarks of Apple Inc. Copyright © 2007-2015 Apple Inc. All rights reserved.

B 77 AT LRSI .

QlAstat-Dx Analyzer 1.0 f1/*F/it 04/2019



7. %EIEWK Media Size (M F RS

(i “A4” D, BONZEEEST EDHLAE ARG A% A IR A

24TEL. BT, 4% T Set Default Options (¥ B ERIAE) SRARLEERE (K& 78) .

8 [ Set Printer Options - CL X | aF
S o O Gy @ 107.101.138:631/admin

« CUPS.org

* Home

* Administration
» Cl

Set Printer Options

Set Default Options for HP_ Officejet_ Pro_6230

General Banners Policies

Error Policy:

Operation Policy:

http://10.7.101.138:631/admin

General

CMYK  ~
00dpi ~
Tray

Plain Paper

! &

Set Default Options

Banners

ElE

A
g
g
iz

<Jl<

Set Default Opi

Policies

I

stop-printer
jefault

=

<

&
@,
[
g
g
?

Set Default Opi

B 78 BEIEFHIAHR T .

8. %M QlAstat-Dx Analyzer 1.0 Operational Module, #XJ& FT I UL F KSR .«

9. 7t Options -> System Config -> Printer GEIN -> RAME > FTEIPLD T8 HZERFTEINL.
BT ATENNL, SRJE 1% Save (f#£1F) o FTENHLERAE R LAER T .

11.2 2N FTENHLA 2R

PLURITEINLZ S T QIAGEN [#illif H36 % QlAstatDx Analyzer 1.0 GEit USB FILUKRESR:) -

e HP® Officelet® Pro 6230
e HP Color Laserlet® Pro M254dw
e Brother® MFC-9330CDW

WL 11.1 FART, HARITEIHL AT Ae i3S QlAstatDx Analyzer 1.0,
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11.3 FF& A
Y 1 4 R 4 R
QIAGEN GmbH

QIAGEN Strasse 1, D-40724 Hilden, Germany

A QIAGEN HEA R 55 6 H I FR IR (145 & 175 1 o

QlAstatDx Analyzer 1.0 fil /* -t 04/2019

91



11.4 KA H TS %% (WEEE)
AT PR T A AR T AR A A A

TR BB ARAT 5 (T ED RIARR L™ i 5 AR 70— AL BT, A ZIAR A 2 My A
AER,  He AT e BRAFVE A AL BEAUAL A5 € IS0 BEAT AR B

£ S BRI ST S R RS R 1) FL e 4% T DADRAT B AR BRI, R DR LAOR I N S AR REAIBA 5 17
2 i o

MR HEE, QIAGEN FIRHEEIRSS, (HaisMst. fERRE, 5@ ALK WEEE
[BISCESR s  an R B i B QIAGEN $fit, IWTBLG SR AL P HLAF AT WEEE AR 1B

AN A B AT BRI, TR M QIAGEN 445 /0 AL SR SR 5 AR el e b . #2252
FitJE, QIAGEN & HEMMEHLR, ZORERMEEE S DL H R B e il HE, 2508
TSR AL R
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11.5 Fi1E5

WRARHE O TN BB THBE NS, U QIAGEN AKIB(EM{R1E L4, QIAGEN X}
AT UL YAE B s A T T VE T S LRk Ab

FEIZORE T I FT A M RAE R R IRE I 3R L OR 12, B AT aa R WI A A B0 E, ANF
RAORAE, BRIE QIAGEN B RARMLISMIFAL. SRHURE | 35 15 B A G H AL T 721X 2™ )
(B )05 7 PR A R G IR A OR . AR TN (B35 QIAGEN IR 1 AR 5 AR
BRI SR AAFAEA — S R R IR A RAEYS QIAGEN WA EMZIR ), FRIF QIAGEN F g
A AT
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11.6 BAFFRT MY

QIAGEN GmbH, QIAGEN Strasse 1, D-40724 Hilden, Germany ( “QIAGEN” ) 5% (AM&Ek
BN, BV CRRR “BREE” ) #Vral 5 Z IR BV I U S 3 R 2 £ (B B0

o L 0 T D S R P A I A8 0 BB R A B 4 2K, ¥
I P L BB 5 B BTETRORD SRR SIS, TR P 2R 2K

1. BT

T MRAEA VLIS ZME, QIAGEN #Z THERIRMERIKA . AR HA Rk fvrar, R
REJVIE Y N 25 H s T A BA

A7

o BUEIESAAI MBIy, tARER FAE(TH 0 5 HADE A 59, A RERE AT AT
TRy SABAE 3T, AANRARAEVE R SR VFRVE I N AE DL, A RERE AT E /R,
BE IR TRE i SICGRBATAR T s SRR AR B AT LI T4

o SlEA CLImBMmERSN

e RZ QIAGEN F5t-fiffFE, DMEMBAFEEMAMSE . ik, mif. #Ek. 5. R4t
B HA S EAETEUR

o JHBR. . B, TIEGS AR AT AE B AR RAR. A FREARIL

o DMEMTIRIL QIAGEN BAE AT HAt J5 i A0 R P AL B H AN (77 A P A B

o fEAZE A A T At N\ SR A 28 BH A B s P R 55

FAHENUE . AU R EAE — S THEHL B HHZER AR — A ELA
BHRRAS . AZAFR AT RS AE 30 (=1 Rjadl, MASTE.
TERCIAT L5 =05 8 o AR DPIANE F TR 7 o A5 (10 S2AH S A B (IR VR AT IE . VR R/ 8K

BOCAFLTR AT HAR A (R “TRCRAE” O - dbhh, A ASER T QIAGEN {X#d%
TRIAAE BT AR C “SB=T0584E7 ) o JFRRIE AN EE = J7 |l g U S B AR R

FH T SOARR AL, (EREATRMSL HARIIRER . ABIEAR GPL ST T HABTTIRVF AT 205K

WA QIAGEN RMEH =T5 8, WL =7 Bk VF AT 2R AR A& AT R CLI O . i SRR
BET TP, ML B VF AT 26 OR A I F O LA O HE o W SR IFTBCA T BAR 2V RT 2%
AEER QIAGEN [ SR RTT AT AR RAJEAAD, T QIAGEN Hgd it R 58 =
Jr AR SOTTBCEAT, QIAGEN KA, FFARYE ZRFL UM R AT 263K
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2. Ttk
A0 RAZ A R I CARTRRAS T, U468 ) B R A5 PR S R A VR AT, T EL A AN RE S St Lk LR 1
A, BRAE— M B AP BB TH R RN I Z AR A e ik 4 55— NP, R 4
TP

3. WM

AHAE CRAEARBAE P FE AT R RICAD) SZRRBUOR Y, 5278 [ RRASL T2 A B 2 20 B 5E 1 O
o SEAFEBABAT BE BT A AEAT EDRIAS L o

4. JLARBRA

G AL B T AR A, (B R RE T L IR 22350, HF AN R A B3R 25K

S AT LAZR A RS B0 AT Y 10 45 TR R L2 S e R TP o AR X AR AT A TR R
GBS G o A (AT AT e L0 20 5 B BT R AS AN i A 58 RS

5. fIRMELR

QIAGEN fRilE: (a) AR EIZ HA Lt (90) KN RENS #4 BB FH B ENRIATBRHEAT o AR BT
ABURERIRILT (90) Ko FEEM/RREE XA S VF IR BORH ORI, - R B SR PR i) mT B
XHEANE

6. B)HIANREE

QIAGEN I aHB ST (e —#hBEE K2 (B QIAGEN it4%) (a) IBIE D XATHIMHEEL (b)
BEBEHRAR G QIAGEN A FRILMIF I IR IRIL S QIAGEN [MIF . tn itk /2 th
TREA. WHBERERR, WA BRIERTCR . AT AT 5 45 A 4 A K A2 SR AG 0 ) 381 43 B[R] Y
=1 (30) RNIRIE, PUEKE N,

7. HWRIHUE

TEATAIE O, QIAGEN BRI f 3545 Xof R 45 P BTG 12 A1 FH AR SR A 1T 3 ST AT 42 35 (LA
APRF D ANEIR S SR, B S E R SRS R . ATEULMHE. BRI
B RN B B 2k - BRI W B - B = RIEE B ) AR BT, RIE
QIAGEN CL &5 &1 ml e B A 24 %

L3R BT PRI AE F T R AT ek G RIE R 3 B BT E, B TR TR
(Produkthaftungsgesetz)  FHAR B H A2 o il P 0 5 AT A 524
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IR PR G A T PA R 1L

e kiR,
K] St e T s £
T IR B (W 3o

8. Rif

A AR TN A SR H] QIAGEN NAFAFRAEM S H . QIAGEN AL (H¥A 55
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